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This user guide is designed to allow a user to set up and conduct an EchoBoat survey and to 
undertake basic data processing. In practice, most data processing will need to be more 
advanced and in relation to the intended application of the EchoBoat. Use the “Help” section of 
HyPack if you have any issues with the data post-processing that are not treated in this 
document. For further information, especially on the EchoBoat, please contact Prof. Stuart Lane 
(stuart.lane@unil.ch), Prof. Stéphanie Girardclos (stephanie.girardclos@unige.ch), Aurélien 
Ballu (aurelien.ballu@unil.ch) or Davide Mancini (davide.mancini@unil.ch). 
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1. Introduction 
 
The Swiss National Science Foundation supported the purchase of an EchoBoat 
system during the calendar year 2019, with matching funds provided by the 
University of Lausanne and the University of Geneva. This manual is designed 
to allow effective deployment of the EchoBoat and also to provide some 
introductory guidance regarding data processing. 
 
1.1 The EchoBoat system 

 
The EchoBoat system comprises a miniature multi-beam echo sounder (the Pico 
MB120SF) that is mounted on a specially designed micro-boat, the latter also 
containing an integrated differential GPS (dGPS) system and allowing for both 
autonomous navigation and towing behind a boat or on rope-pulley-systems. 
The lightweight nature of the PicoMB120SF (<5 kg in air) reduces the draft 
meaning that the system is especially suitable for autonomous deployment in 
shallow water bodies, in optimal conditions up to 240 m depth. 
 
The PicoMB120SF measures distances from the sensor of up to 240 m. It emits 
256 beams instantaneously at a frequency of 337-450 kHz and with an angle of 
0.47o between beams making a swath angle of 120o. Each beam spreads along 
its distance of travel at an angle of 1.4o. It has been specifically developed to 
work at shallow depths (>0.5 m depth, reliable >0.8m depth). As it is 
lightweight, it is mounted on a specially designed platforms, which can be 
motorised to operate remotely or rope-towed, behind a boat or from bank 
attached rope-pulley systems. 
 
The PicoMB120SF is integrated with a dGPS system, two antennas (necessary 
to resolve heading, heave, pitch, yaw and roll precisely), and a continuously 
recording probe for temperature and spend of sound profiling, and post-
processing software.  
 
The depth resolution of the sensor is 37 mm, lower than other larger, heavier 
and more powerful MBES platforms which can survey to greater depths but can 
only be boat based limiting their use for shallow flows in rivers and shallow lakes. 
Tests with the instrument show that the maximum surveyed depth is around 40 
meters. Starting from this depth, several noise sources and artifacts will appear.  
 
Data are collected by Hypack control software and it is vital that the computer 
that will be used with Hypack is checked in terms of communication with the 
EchoBoat and that the necessary dongle is available. 
 
For dGPS communications there are two solutions. One uses the EchoBoat 
system coupled directly via cell phone to a continuously communicating fixed 
GPS network (like the Swiss Positioning Service, SwiPos-GISGeo). The other 
one, consist in connect the EchoBoat to a fixed dGPS base (e.g. Trimble) using 
it as a rover.  
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2. EchoBoat and PicoMB120SF inventory  
 
The following inventory should be checked against the equipment before leaving 
for field data collection and upon return. Any missing components should be 
flagged with the UNIL technician responsible (currently aurelien.ballu@unil.ch).  
 

1.1 EchoBoat 
• 1x EchoBoat hull with thrusters 
• 1x EchoBoat internal mounting deck 
• 1x EchoBoat lid  
• 10x lid screws 
• 1x sonar (PicoMB120SF) mount 
• 2x EchoBoat support frame 
• 1x EchoBoat mast  
• 8x socket cap screw  
• 8x nut  
• 16x washer  
• 8x lock washer  
• 2x EchoBoat fins  
• 1x Taranis FrSKY X7 remote controller 
• 1x Ansmann remote controller charger 
• 1x Venom PROQUAD battery charger 
• 4x LiPo 4S battery 
• 2x LiPo 6S battery  
• 2x bolt (installed on mast)  
• 2x nuts (installed on mast)  
• 4x washer (installed on mast)  
• 2x lock washer (installed on mast)  
• 1x rear pole mount bracket 
• 2x rear pole mount clamps socket screw 
• 3x XT90 parallel connector  
• 1x Allen driver 1/4  
• 1x Allen driver 1/8 
• 1x Allen driver 3/16 
 

1.2 PC Wi-Fi communication kit 
• 1x industrial PC 
• 1x industrial PC power supply 
• 2x Ethernet cable 
• 2x N-type M/F connector (installed on boat and mast)  
• 1x N-type to N-type 18” cable 
• 2x 18” Wi-Fi male Wi-Fi antenna 
• 1x 18” Wi-Fi female antenna 
• 1x USB optical isolator 
• 1x boat side Wifi bridge 
• 1x shore side Wifi bridge + PoE adapter 
• 3x US to CH plug adapters 
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1.3 AutoNav 
• 1x AutoNav topside 
• 2x antenna 
• 1x USB antenna adapter 
• 1x port motor to AutoNav cable 
• 1x starboard motor to AutoNav cable 
• 1x AutoNav charger 
• 1x RS232 to amphenol male cable 
• 1x RS232 to amphenol female cable 
• 1x amphenol male to amphenol female cable 

 
1.4 PicoMB120SF  
• 1x Pico topside 
• 1x Pico RX transducer 
• 1x Pico TX transducer 
• 1x Pico power/data cable 
• 2x Trible GPS antenna 
• 3x 3ft TNC to TNC GPS antenna cable 
• 1x 6ft TNC to TNC GPS antenna cable 
• 1x Ultra SV 
• 1x Ultra SV data cable 

 
 

1.5 Hypack 
• 1x Dongle 
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2. Fieldwork checklist 
 
In addition to the EchoBoat, the following items of equipment are needed. 

Item Quantity Check Observations 
For Transportation    

Large van 1   
Platform/foam bars or cart 1   

    
Shore PC / laptop    

Battery (with solar 
panels)/generator 

1   

Shore PC (DELL 25943) 1   
PC power supply 1   

Shore Wifi antenna with 
ethernet cable 1   

Socket Strip 1   
US to CH plug adapters 2   
Rod for shore antenna 1   

Ethernet adapter for shore 
antenna-PC connection 1   

Wifi antenna power supply 1   
    

RTK    
Huawei 4G mobile device 1  

Solution 1 SwiPos-GIS/GEO subscription 1  
Trimble dGPS base + rover 1  

Solution 2 dGPS base tripod 1  
dGPS rover rod 1  

    
Other useful equipment    

Tape 1   
Waders 2   

Tent to protect the EchoBoat 
(only in case of long 

fieldwork) 
1 

  

Camping table for shore PC 
station  

1   

Venom PROQUAD charger 
(only in case of long 

fieldwork) 
1 

  

Remote controller charger 
(only in case of long 

fieldwork) 
1 
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3. Fieldwork guide 
 
3.1 Charge the EchoBoat’s batteries  
 
The EchoBoat’s batteries are charged using a Venom PROQUAD charger with 
four individual charging channels. It is important to note that the EchoBoat is 
powered by two types of LiPo batteries (4S and 6S, see labels on the battery), 
which need different settings on the charger.  
 

The 4S LiPo batteries are used to power the two propellers (thrusters); 
they have to be installed horizontally in the compartment behind the Pico 
on the aft of the boat.  
 
The 6S LiPo batteries supply all other electronic devices; they have to 
be installed horizontally on the bow of the boat (it is necessary to remove 
the AutoNav for loading and unloading operations). 

 
ATTENTION: charge the six batteries the day before their deployment 
and ensure that each battery is fully charged (check their status using the 
red Venom voltmeter). Every battery should have at least a voltage of ca. 
4.3v/cell; never use the system if the voltage drops down the limit of 3.7v/cell 
to avoid damage. When fully charged, the batteries should supply power for 8 
hours (depending on several factors as, for example, the survey cruise speed). 
 

1. Prepare the Venom PROQUAD charger 
a. Connect one balance connector to each of the four charging channels 

on the front of the charger (Figure 1). 
 
 
 
 
 
 
 
 
 
 
 
 

 
b. Connect the four XT90 plug leads to each charging port (black plug into 

the black port; red plug into the red port). Each lead should be inserted 
in the same vertical channel (Figure 2).  

Male balance connector 

Figure 1: Front side of the Venom PROQUAD charger and balance connector cables 
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c. Each battery comes with a male XT90 plug and a male balance 
connector (Figure 3).  

 
 

 
 
 
 
 
 
 
 
 
 
 

  
 

d. Connect the male XT90 plugs from the batteries to the charger’s female 
XT90 leads (Figure 4).  
 
 
 
 
 
 
 
 
 
 
 
 

e. Connect the male balance connectors from the batteries to each 
charger’s female balance connectors (Figure 5).  

Female XT90 plug 

Male balance 
connector 

Male XT90 plug 

Female balance 
connector 

Figure 2: Venom PROQUAD channels plugged with both XT90 and balance connector cables 

Figure 3: battery’s connection plugs 

Figure 4: XT90 connection between the charger and the battery 
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f. Each battery must be connected with the XT90 and the balance 
connector leads coming from the same channel! If hooked up 
incorrectly, the charger will display a battery voltage error! 

g. Plug the three-prong power cord into the back of the charger. Use an 
US to CH plug adapter to connect the charger to an electrical outlet. 

h. The Venom PROQUAD charger automatically turn on. 
i. As the charger own four channels, it is possible to charge up to four 

batteries at the same time (cycle to the different channels - see below). 
 

2. Charge the 4S LiPo batteries 
a. 4S batteries charger settings: 

- Type of battery = LiPo BATTERY 
- Type of charge = LiPo BALANCE 
- Amperage = 6.0A 
- Voltage = 14.8v 

b. On the PROGRAM SELECT menu choose LiPo as battery type (“LiPo 
BATT”). The charger should already display this option but, if it is not 
the case, change it using the SELECT/STOP button and then press the 
START/ENTER button to confirm the choice. 

c. Check that the charger mode is corrected for the type of connected 
battery. If settings display anything other than “LiPo BALANCE” use the 
DEC and the INC buttons to adjust it (ATTENTION: do not use “LiPo 
CHARGE” as charging mode!). Press the ENTER button to confirm 
(Figure 6). 

d. To adjust the amperage (6.0A) and voltage (14.8v) settings, press the 
ENTER button until the setting you want to change flashes then press 
either the DEC or INC button to change the values (Figure 6). Press the 
ENTER button to confirm. 

Figure 5: balance connector  
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e. To start charging press and hold the START/ENTER button for 2 
seconds. A battery check will be performed by the charger, press the 
START/ENTER button to confirm. The charging of the battery will 
immediately start.  

f. If more than one 4S battery is connected to the charger, cycle through 
the different channels using the CHANNEL button and then repeat 
points 2a. to 2e. for each used channel (the red LED will illuminate over 
the channel that is currently selected).  

g. When a battery is fully charged (at 16.8v), the charger will display a 
“FULL” message on its top-left corner and emits a tone. Press the STOP 
button and then disconnect the battery (repeat the operation for every 
channel). Use the CHANNEL button to cycle trough the different 
channels and check their charging status.  
 

3. Charge the 6S LiPo batteries 
a. 6S batteries charger settings: 

- Type of battery = LiPo BATTERY 
- Type of charge = LiPo BALANCE 
- Amperage = 6.0A 
- Voltage = 22.2v 

b. Repeat the instructions given for the 4S batteries (point 2a to 2g) 
changing the settings for the voltage (22.2v). The batteries are fully 
charged at 25.3v. 
 

4. The Taranis FrSKY X7 remote controller has its own charger. Connect the 
balance connector cable to the plug on the side of the remote controller 
(Figure 7) and plug the charger to an electrical outlet using an US to CH 
adapter. Once the battery is full (the green LED on the charger stops 
blinking and display a steady light), press the little lever on the balance 
connector plug and remove the connector cable from the remote 
controller. 

Figure 6: Venom PROQUAD charger displaying the right settings for the 4S batteries 
and meaning of the different buttons 

Channel 

Start/Enter Select/Stop 

DEC/INC 

Selected channel 
from 1 (left) to 4 

(right) 
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IMPORTANT considerations about the LiPo batteries: 
 

• Batteries should be supervised while charging even if we already preset 
the charger capacity limit at 16000mAh in order to avoid overcharge (risk 
of fire and/or explosion). In this regard, place the charger and batteries 
on a heat-resistant, non-flammable and non-conductive surface during 
charging operations. Immediately discontinue the charging and isolate the 
battery if it begins to swell/“balloon” or it reach very warm temperatures! 
 

• Use batteries only if their voltage is at least of 4.3v/cell. Don’t use them if 
their voltage drops down under the 3.7v/cell limit to avoid possibly 
damaging effects. 
 

• If the EchoBoat is not to be deployed for a long period of time, discharge 
the batteries to preserve their life. Set the Venom PROQUAD charger on 
the “STORAGE” mode and discharge them down to their nominal storage 
voltage of 3.75v/cell.    
 

• Do not expose batteries to cold (< 2oC) or extremely hot (>35°C) 
environments when they are not in use (storage period or fieldwork). 
These extreme environments may impact on the battery lifetime and 
produce rapid discharge. If possible, it is recommended to protect the 
batteries using the LiPo safety bags.  

 
3.2 EchoBoat assembly  
 
Normally the EchoBoat is already assembled and, in order to do not modify the 
offsets between the primary GPS antenna and the IMU (Inertial Measurement 
Unit; assembled on the Pico), it should not be dismantled. Only the batteries 
should be removed for charging purposes. 
 
However, if the EchoBoat has to be dismantled (i.e. maintenance, airplane 
transportation, etc.), please follow these assembly phases: 

Figure 7: Charger plug on the side of the remote controller 
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1. Put the EchoBoat on a stable surface (preferably a soft one in order to 
avoid damaging the hull). In this regard, use the two foam bars available 
inside the EchoBoat’s crate. Pay attention to the thrusters – they 
should not touch the foam!  
 

2. Install the PicoMB120SF (Pico) inside the circular panel (mount) in the 
middle of the deck (Figure 8A). The transmitter/receiver arrays should be 
out of the boat and in contact with the water, while the connectors (the 
Applanix system) have to be inside the boat with the plugs oriented in 
direction of the bow of the EchoBoat (Figure 8B). 

 
ATTENTION: always check that the Pico is correctly fixed to its mount (4 
screws are necessary!) in order to avoid water infiltration; in addition, 
ensure that the transparent cable (water evacuation) is not obstructed by 
sediments, weed, etc.! 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

3. Install the boat PC in front of the Pico (Figure 9) and secure it to the deck 
of the boat with the appropriate yellow screws. 
 
 
 
 
 
 
 
 
 
 
 
 

  

Screw 
Pico’s mount Receiver/Transmitter Applanix system 

Boat PC 

Pico 

Figure 8: A) Pico mount on the EchoBoat and B) different components of the Pico 

Figure 9: boat PC installed near the Pico  

A 
 

B 
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4. Connect the Pico to the boat PC (black ethernet cable), to the power supply 
(XT90 plug and amphenol cables; the color labels on the cable and on the 
plugs must match), to the transmitter/receiver array and to the two GPS 
antenna plugs located on the aft of the EchoBoat (see labels on cables).  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

5. Connect the boat PC to the boat side Wifi bridge (MikroTik) using the 
ethernet cable of the gray PoE adapter (Figure 11). Make sure that the 
MikroTik’s power supply is also connected to the PoE adapter! 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

6. Batteries are stored in two different panels: 
• The four 4S batteries are fixed to the back of the boat (behind the 

Pico). Remove the two black belts, connect the male XT90 plugs 
from the batteries to the two yellow EchoBoat’s female XT90 
connectors (two batteries for each plug) and load them horizontally 
with the leads facing the thrusters (Figure 12A). Before fixing them 
with the two belts, ensure that the two thrusters’ sensors are turned 
on (Figure 12B).  

PoE adapter 

MikroTik’s 
power supply 

cable Boat PC 

Figure 10: Connection between the Pico, the boat PC and the GPS antennas 

Figure 11: Connection between the boat PC and the MikroTik (wifi bridge) 
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• The two 6S batteries are stored on the bow of the boat (behind the 

AutoNav). Remove the belt, connect the male XT90 plugs from the 
batteries to the EchoBoat’s female XT90 connector, insert them 
horizontally and, finally, secure them with the belt. Both battery’s 
XT90 leads should be oriented facing the left side of the hull (Figure 
13). For loading and unloading the two 6S batteries, it is necessary 
to remove the AutoNav! 
 
 
 
 
 
 
 
 
 
 
 
 

 
7. Install the AutoNav next to the boat PC, and in front of the 6S batteries, 

fix it to the deck with two black screws. Ensure that the blue USB cable 
coming from the PC is well connected on the left side of the Autonav. Plug 
the two black amphenol cables on the front side and connect the gray one 
to the Applanix system (MV-POS integrated into the Pico topside) using 
the RS plug coming from the Pico labelled as COM 1 port (never use COM 
3!). 
 
 

 
 
 
 
 
 
 

AutoNav Boat PC 

Figure 12: A) 4S batteries panel on the aft of the EchoBoat and B) thruster sensor 

Figure 13: 6S batteries panel on the bow of the EchoBoat 

A 
 B 
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8. Installation of the support frame for the GPS and Wifi antennas 

• Remove the four handles from the EchoBoat using the provided Allen 
keys. 

• Install the two black support frames (mast support) putting their 
edges between the hull and the handles (Figure 15). The two support 
frames must be parallel to them and cross the EchoBoat from side 
to side. Fix them using the same screws already used to fix the four 
handles. 
 
 
 
 
 
 
 
 
 
 
 
 
ATTENTION: the support frame with straight bases should be 
installed on the aft of the EchoBoat (Figure 16A), while that with 
oblique edges goes on the bow (Figure 16B). 
 

 

Support frame 

Handler 

Figure 14: AutoNav connection to the batteris, the boat PC and to the Pico 

Figure 15: Support frame installation on the EchoBoat 
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• Install the mast (the long black steel bar) perpendicular to the two 

support frames passing by their middle. Fix it to the two frames 
using eight socket cap screws, and relative nuts and washers (each 
screw needs one nut, one washer, one lock washer and one bolt; 
Figure 17). Make sure that the mast side tagged with “F” (“Front”) 
is oriented in the direction of the bow.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Install the two GPS antennas ensuring that the “Trimble” labels are 
both aligned and parallel to the mast. If not, rotate them moving 
their bolts located on the down face of the mast (use a wrench). 

• Connect the GPS antennas to their plugs installed on the aft of the 
EchoBoat using the two TNC to TNC cables. The GPS antenna 1 is 
that on the aft (use the 3ft cable), while the GPS antenna 2 is that 
on the bow (use the 6ft cable) (Figure 18). Use a waterproof tape to 
protect the connections against the ingress of water (optional). 

• Install the Wifi antenna at the intersection between the mast and 
the mast ‘support frame on the bow (Figure 18). 

 

Mast 

Support frame 

Socket cap screw 

Nut 

Washer 

Washer 

Lock washer 

Figure 16: Support frame base – A) aft of the EchoBoat, B) bow of the EchoBoat 

Figure 17: components for the installation of the mast on the support frames 

A 
 

B 
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9. Close the EchoBoat’s lid and screw the ten black screws by hand. Use your 
hand to exert additional pressure on the lid (Figure 19) to better protect 
and waterproof all the electronical devices. This is a critical step. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Install the two fins on the aft of the EchoBoat sliding them on the 
two tracks (Figure 20). It is recommended that these are installed only 
before the beginning of the survey and removed once the survey is 
finished to avoid damaging effects.  

 
 
 
 
 
 
 
 
 
 

 
 
 

Fin 

Sliding track 

Support frame 

Mast 

Wifi antenna 

GPS antenna 2 

GPS antenna 1 

GPS antenna plugs 

Figure 18: EchoBoat assembled  

Figure 19: Proper way to close the lid 

Figure 20: Fins installation on the hull 

TNC to TNC cable 
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11. Once the EchoBoat is assembled, it is necessary to measure the 
distance between the IMU reference point (Pico 120 MBES Topside phase 
center; Figure 21), the primary GPS antenna located on the aft of the 
EchoBoat (Trimble GPS Antenna phase center; Figure 21) and the Acoustic 
Center of the Multibeam (Pico 120 MBES phase center; Figure 21) in order 
to calibrate data positioning precision. 

 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 

 
The offsets shall be entered in both the MV-POSView and HyPACK 
programs.  

• In the MV-POSView software, measure and enter the IMU and 
GNSS antenna offsets. The values have to be entered on the 
“Installation” tab (“Lever Arm & Mounting Angles”) under the 
“Settings” list of MV-POSView (Figure 22).  

A 
 

B 
 

Figure 21: scheme illustrating the location of the phase center on the IMU (A and B), on the 
primary GPS antenna (C and D) and the reference distance between them (A and B). 

C 
 

D 
y 
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o “Ref. to IMU Target” box 
- Enter the value of the distance between the Pico 120 

MBES topside phase center and the waterline on the “Z” 
box. The vertical offset is positive downward. 

- The “X” and “Y” boxes have no offsets and they must be 
set with 0 values. 

o “Ref. to Primary GPS Lever Arm” 
- Enter the distances forward and starboard from the Pico 

topside phase center and the Trimble GPS Antenna 
phase center. These offsets have to be entered on the 
“X” and “Y” boxes. Positive values mean that the primary 
GNSS antenna is forward/starboard to the IMU reference 
point. 

- Enter the distance from the Primary GNSS Antenna 
Phase Center to the waterline on the “Z” box. A negative 
value means that the antenna is above the waterline. 

 
• In HyPACK measure and enter the multibeam offsets. The values are 

entered on the “Hardware setup” (“Picotech PicoMBES” device) 
under the “Offsets” tab (Figure 23).   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 22: Lever arms & Mounting Angles tab on MV-POSView 

Figure 23: Multibeam offsets in HyPACK 

All the values 
have to be 0! 

Y values has to be 0! 
Not the other ones… 
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o Choose “Sonar Head 1” on the dropdown menu 
- Enter the distances forward and starboard from the Pico 

topside phase center to the Pico phase center. Enter the 
values in the “Starboard” and “Forward” boxes. Positive 
values mean that the Acoustic Center of the Multibeam 
is forward/starboard to the IMU reference point. As it is 
very difficult to measure these distances, it worth to use 
the values given in Figure 21A. 

- Enter the distance from the waterline to the Pico 120 
MBES topside phase center on the “Vertical” box. A 
negative value means that the Acoustic Center of the 
Multibeam is above the waterline. 

 
12. The first time the EchoBoat is used in a survey after having been 

dismantled, it is also important to perform a GAMS calibration (GPS 
Azimuth Measurement Subsystem) 

a. Turn on the EchoBoat, connect it to the shore PC, and start a new 
project  

b. Open MV-POSView (Figure 24) 
- Wait until the IP address is displayed (Pico connected to boat 

PC) 
- Click the “Connect” and the “NAV” buttons 
- Enter the measured offsets  
- “Settings” -> GAMS calibration (all the “Accuracy” alarms 
must be green. If not manually move the EchoBoat) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

c. Once the EchoBoat is in the water, start the GAMS calibration (Figure 
25). Move the boat conducting initially continuous circular 
trajectories and then straight lines with several stops (refer to 
Chapter 3.3 to know how to prepare the EchoBoat for the field). 
 

Figure 24: MV-POSView main window 

Connect/Disconnect 

NAV  

IP address 
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d. Once the GAMS calibration is finished (the status bar reached 
100%), close MV-POSView saving the changes. 

e. When you start a new project in HyPACK, remember to enter the 
measured offsets on the “Hardware Setup” settings.  
 

13. Patch Test 
a. Every time the EchoBoat is dismantled, it is also important to 

calibrate the angular mounting components (GPS Latency, Roll, Pitch 
and Yaw parameters). 

b. To perform the Patch Test, and to have a detailed workflow to follow, 
refer to Chapter 4.3 

 
 
 
3.3 Deployment in the field 
 

1. Put the EchoBoat on a stable surface (paying attention to the thrusters 
and to the fins!) 

2. Open the EchoBoat lid 
a. Ensure that the HyPACK dongle is connected to the boat PC (Figure 

26) and that all cables are correctly plugged in (see chapter 3.2) 
 
 
 
 
 
 
 
 
 
 

 

Boat PC 

Boat PC 
On/Off button 

HyPACK dongle 

Figure 26: Boat PC inside the EchoBoat and HyPACK dongle 

Figure 25: POS calibration status 
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b. Load and plug the six batteries (point 3.2.6) 
c. Turn on the boat PC’s lever (on the aft of the EchoBoat; Figure 27) 

 
 
 
 
 
 
 
 
 
 

d. Turn on the boat PC (little button on the lower-right corner; Figure 
26) 

ð Tone + lights = power from the boat PC to all electronical 
devices 

e. Turn on the lever of the starboard thruster (STBD, on the aft of the 
EchoBoat; Figure 28) 

ð Tone = power from the starboard to the AutoNav 
 
 
 
 
 
 
 
 
 

f. Turn on the AutoNav’s lever (Figure 29) 
 

 
 
 
 
 
 
 
 
 

g. Turn on the lever of the port thruster (PORT, on the aft of the 
EchoBoat) to complete the thruster ignition (Figure 28) 

h. Turn on the SONAR lever (on the aft of the EchoBoat) to turn on the 
PICO (Figure 27). It is recommended to turn on the PICO only once 
the EchoBoat is in the water. However, it is also possible to turn it 
on even when the boat is outside the water but, in this case, it is 
necessary to change the beam frequency rate to 1 Hz (section 
3.3.7.e) 

3. Turn on the remote controller and rotate the antenna (Figure 30) 

Figure 27: Pico and boat PC levers ignition 

Figure 28: Thruster ignition levers 

Figure 29: AutoNav’s lever (inside the red circle) 
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a. Check the connection bars on the display 
b. Arm the EchoBoat (flip down the Arm/Disarm AutoNav lever and 

hold the ARM/DISARM safety towards the operator for 3 seconds) 
ð You will hear a tone (“beep”) from the EchoBoat 

c. Check that thrusters correctly respond to the remote controller  
ATTENTION: only the right stick controls the EchoBoat in the 
manual mode 

d. Disarm the EchoBoat (flip up the Arm/Disarm AutoNav lever and 
hold the ARM/DISARM safety towards the operator for 3 seconds). 
It is recommended to arm the AutoNav only once the EchoBoat is in 
the water and ready to start the survey (see point 3.3.8) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Close the EchoBoat lid 
a. ATTENTION: while closing the screw, use your hands to put 

additional pressure on the lid in order to expand the force on a 
greater area and improve the waterproof effect (Figure 19) 
 

5. Prepare the shore PC (it must be the UNIL DELL 25943) station 
a. Connect the shore Wifi antenna to the shore PC (Figure 31) 

ð Connect to the PoE adapter the antenna’s ethernet cable and 
its power supply 

ð Plug the PoE adapter to the shore PC (port on the back) and 
the antenna’s power supply to an electrical outlet (ex. 
portable battery or generator) 

ð The shore PC’s power supply must be plugged to an electrical 
outlet in order to avoid an unexpected shutdown during the 
survey! 

Manual/automatic mode 
Down = manual 
Up = automatic 

Arm/disarm AutoNav 
Down = disarm 
Up = arm 

ARM/DISARM 
safety: Up for 5 
seconds 

Hold the PAGE 
button to check the 
EchoBoat’s batteries 
voltage on the 
display 

Command stick 

Turn on/turn off 
button 

Antenna 

Figure 30: Remote controller and main commands 
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ð Use a socket strip to connect the devices to the 
generator/portable battery 

ð If needed, use some US to CH plug adapters 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

b. Check the connection bars on the Wifi antenna 
c. Put the Wifi antenna on an elevated position (use a rod/pole if 

necessary) 
ð It is important to have a clear vision of the whole survey area 

d. Connect the shore PC to the boat PC via remote desktop connection 
ð Use the IP address of the PC ethernet port that the MikroTik 

plugs (IP = 192.168.1.8) 
ð Username: EchoBoat 

Password: Seafloor 
6. Open MV-POSView software (Figure 32) 

a. Press the “Connect” button 
b. All the alarms on the “Accuracy” list (Heading, Position, Velocity, 

Heave) must to be green! 
ð If not, move the EchoBoat in a circular way until the alarms 

turn green 
ð It is not necessary that the “Attitude” alarm is green 

c. Press the “NAV” button 
d. Look at the number of satellites connected to the EchoBoat (View 

tab -> GNSS data). For a good operation, they may have between 
15 and 20.  

e. Check the MV-POSView clock. It must be synchronized with the boat 
PC clock (maximum 1 second delay). If it is not the case, connect 
the shore PC to the boat PC using an ethernet cable and manually 
set the shore PC clock (Parameters -> …). 

f. Minimize the MV-POSView window 
 

PoE adapter 

Shore PC 
UNIL DELL 25942 

Shore PC 
power supply 

Wifi antenna 

Battery 

Socket strip 

Antenna power supply 

Figure 31: Equipment needed to install the shore PC station 
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7. Open HyPACK 64-bit  
a. Create a new project  

ð File -> new project -> name it as “date + name of the 
surveyed area” (ex. 5142019_ouchy) 

ð To load an existing one to continue the survey: “Project 
Manager” list -> search the project name -> double click (the 
project turns green) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

b. Determine/check the geodesy settings (Figure 33 and 34) -> 
CH_1903 (if the survey area is in Swiss) 

Figure 33: HyPACK main window and location of the main tools 

Hardware 
setting 

Geodesy 
setting 

Figure 32: MV-POSView alarms 
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c. If you want to add a background chart to the project map (not 
mandatory for the survey, but it may useful to see the spatial limits 
of the surveyed area; see point 9b) 

ð Right click on “Background Files” folder in the “Project Files” 
list 

ð Select “Add file”, choose the file format, search the file and 
click OK 

ð The chart will be appeared to the screen and stored in the 
“Background Files” folder 

ð The background chart should be georeferenced! 
d. Check the hardware settings (Figure 33) 

ð The sidebar should show the following parameters (Figure 
35) 
 

Figure 34: Geodesy window 
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ð Check that the offsets between the primary GPS antenna 
and the MRU are correct. If not, manually insert them 
(Figure 23): 

• Click on “Picotech PicoMBES” in the tree view 
• Click on the “Offsets” tab 
• Select “Sonar Head 1” on the dropdown menu 
• Enter the measured position offsets  

 
e. Prepare the survey  

ð “Survey” tab (Figure 33) -> “HyPACK survey and HySWEEP 
survey” 

ð At this point you will hear a continuous “beep”. This is an 
alarm informing you that no tide data is used. Select the 
“Survey” window and press the ESC button (on the shore 
PC’s keyboard) to disarm the warning message. 

ð All the alarms on the “HySWEEP survey” window (NAV, Gyro, 
MRU, Multibeam, Devices; not the Side Scan that stay in 
gray; Figure 37) must be green! Pay also attention that the 
“Boat Info” option is selected to obtain live data from the 
Pico. 
If the alarms are not green, the problem may be 
related to an incorrect distribution of the power (check 
that all cables are correctly into their plugs) or to a 
bad connection between HyPACK and MV-POSView 
(close all and repeat point 3.3.6 and 3.3.7). 

Figure 35: HyPACK hardware settings 
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ð If nothing appears on the “Profile” window, which shows the 
real time sounding, it is necessary to control and to change 
the beam frequency: “HySWEEP survey” window -> Tools -
> PicoTech controller -> Frequency 
(for shallow water, it is recommended to use value of ca. 
25Hz). 
Adjust swath depth and width (c. 1.5 x depth) in function of 
you study area. 

ð Determine matrix (resolution) using the “Multibeam Matrix 
Settings” (Figure 38)  

-> Cell size/grid size tab = set the cell resolution 
-> Select the data type you want displayed on the real 
time color map (“Average depth” is typical) 
-> “Update” tab = while logging 

 
 
 
 
 
 

8. Put the EchoBoat in the water  
a. Arm the AutoNav  

ð Just before to start the survey! 
ð Flip up the Arm/disarm lever and hold the ARM/DISARM 

safety towards the operator for 3 seconds (see point 3.3.3 
and Figure 30) 

ð The MAVLINK window will show that the AutoNav is armed 
 

9. Start the survey 
a. Wait until the “NO SYNC” alarm is gone (Figure 39) 
b. Press the start logging button to record data (Figure 39) 

 
 
 

Figure 37: HySWEEP survey alarms 

Figure 38: “Multibeam Matrix Settings” icon on the “HySWEEP survey” window  
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ð Bathymetry chart appears on the “Survey map” window 
ð Status change from NOT LOGGING to LOGGING (Figure 40) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
c. It is recommended to divide the survey into two distinct stages 

(depending on its extent and configuration): 
ð I: map the spatial limits of the surveyed area (“safe 

area”) using the manual mode or using the “Contour editor”. 
On this latter case: 

• “Preparation” tab on the HyPack main toolbar  
• “Contour” editor => click the “Cursor” button and 

draw a polygon on the map 
• Save the edited lines (lines will be saved on the 

“Contour Files” folder inside the “Project Files” list 
ð II: map the area inside the limits using the automatic 

mode. This operation needs several steps: 
- Close “HySWEEP survey” window (Figure 37) and save 

the logged data 
- On HyPACK 2019 64-bit 

 
• Click the “Line editor” icon (Figure 41) 

Figure 39: Position of the Start logging button on the HySWEEP survey window  

Figure 40: Logging status on the HySWEEP survey 
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• Click the “Cursor” button (Figure 42) 

 
 
 
 
 
 

 
 
 
 
 
 

 
 

 
• Draw one line inside the survey area limits 

(Figure 43) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Re-open the “Line Editor” window clicking the icon 
on the lower left part of the display (Figure 43). 
Press “Offsets” button on the Editor Line menu 

Figure 41: “Line Editor” icon 

Figure 42: Line Editor window; Cursor and Offsets buttons 

Figure 43: Single line path  
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(Figure 42) -> add the number of lines that you 
wish and the spacing between them (in meters) 
(Figure 44). Note: to clip the parallel lines inside 
the contour, use the “Clip Lines” button (Figure 
42) and then select the “Border file” you created. 

 
 
 
 
 
 
 
 
 
 
 
 
 

• Click “OK” and save the edited lines (file-> save)  
  ATTENTION: lines have the same direction 

(Figure 45) 
 
 
 
 
 

 
 
 
 
 
 

 
 

• To reverse their direction (Figure 46): Open the 
line Editor -> File -> Open -> select the lines that 
should be reversed (CTRL+left click) -> right click 
-> Reverse Order 

Figure 44: Offsets windows  

Figure 45: Offsets output; lines have all the same direction  
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• Save again the edited lines (the file will be stored 
on the “Planned Line Files” folder inside the 
“Project Files” list; Figure 46)   
 

d. Once the lines are planned, launch the EchoBoat on the autonomous 
mission mode (no need to switch the remote controller on the 
autonomous mode; Figure 30) 

ð On HyPACK, select one planned lines files at a time. If you 
decided to use the “Border editor” to generate a safe area, 
select and execute this file at first. If you did it manually, you 
can directly select the parallel lines to fill the limits.  

ð Restart the survey clicking the “Survey” tab (Figure 33) 
ð Choose “HyPACK survey and HySWEEP survey” 
ð Move the EchoBoat close to the starting point of the line 1 
ð MAVLINK window => Start mission (Figure 47) 
ð At the end of the mission, to take control of the EchoBoat it 

is necessary to switch the manual/automatic lever to 
automatic mode and then to manual mode! 

ð It is necessary to stop/start logging at the beginning of every 
line (depending on the settings: “Survey” window -> Options 
-> Navigation parameters) 

- “Start line gate” = 0: the survey program starts and 
stops logging only if you manually intervene 

- “Start line gate” > or < 0: the program starts logging 
automatically when the distance from the tracking point 
to the starting point of the planned line is less than the 
absolute set value. The trigger area is shown as a circle. 
A positive offset shifts the circle down line by the 
specified amount, while a negative offset shifts it 
backward along the line. 

Figure 46: Lines with different directions and “Planned Lines Files” 
folder 
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ATTENTION:  
- if during a mission there are some obstacles on 

the paths of the EchoBoat, press “Pause” from the 
MAVLINK window or turn the remote controller to 
manual mode (Figure 30; three steps: manual -> 
automatic -> manual as it is not necessary to set 
the automatic mode before to start the mission). 
To continue the mission, turn the remote 
controller to the automatic mode. 

- If you decide to abort the mission, press the 
button “Return to Launch” from the MAVLINK 
window. The EchoBoat will return to the point 
where it has been armed (pay attention!). 

- If you wish to continue the survey adding some 
new lines, it is important to deselect the lines from 
the “Planned Line Files” (inside the Project Files) 
and then draw the new lines using the editor. 

ð If you want to continue the survey with other planned 
parallel lines (or contour lines) do the following: 

- Close the HySWEEP survey 
- On HyPACK, select (or generate) another planned lines 

files 
- Restart the HySWEEP survey and repeat point 3.3.9.c. 

 
If the automatic survey is not possible (many natural obstacles on 
the surveyed area, weak GPS signal, etc.). 

ð Manually move the EchoBoat generating parallel lines paying 
attention that all the surveyed area will be covered (look at 
the “HySWEEP map” window). 

ð For every line, press “Start logging” at the beginning and 
“Stop logging” at the end in order to generate multiple lines 

Figure 47: MAVLINK window and Start Mission button  
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(Figure 48). This procedure makes the data post-processing 
easier compared to a situation where the whole surveyed 
area is recorded as a single and long line. 

 
 
 
 

 
 

e. The bathymetry will start to be drawn on the “Survey” map 
ð To change the way in which live data are displayed, press 

the “View” button on the HySWEEP survey windows (Figure 
37) and then choose your preferences (Profile, 3D Seafloor, 
Multibeam Waterfall, Real Time Point Cloud,…) 
 

10. At the end of the survey 
a. Open the PicoTech controller window (“HySWEEP survey” window -

> Tools -> Picotech controller) and turn down the beam frequency 
to 1Hz 

b. Close the main window (“Survey”) in HySWEEP survey to save the 
logged data 

c. Shutdown the boat PC from the shore PC 
d. Turn off the thrusters (PORT and STBD levers located on the aft of 

the EchoBoat) 
e. Turn off the SONAR and the PC (levers located on the aft of the 

EchoBoat) 
f. Turn off the AutoNav opening the EchoBoat’s lid 

11. Download data from the boat PC 
a. Open the EchoBoat lid 
b. Turn on the PC lever on the aft of the EchoBoat 
c. Turn on the boat PC  
d. Connect the shore PC to the boat PC using the Wifi antenna or using 

an ethernet cable (you can use that used for connecting the antenna 
to the shore PC) 

e. Connect the two devices using the remote desktop connection 
f. Connect a hard disc to the boat PC  
g. Follow this directory: Computer -> OS (C:) -> HyPACK 2018 -> 

Projects 
h. Search your projects and paste them on the hard disc  
i. Shut down the boat PC from the shore PC -> the remote connection 

will automatically end 
j. Turn off the PC lever on the aft of the EchoBoat to shut down all the 

electronic devices 
 
 
3.4 OPTIONAL: RTK correction during survey  
 
Two main solutions may be used (see “Applanix User guide” pag. 117):  

Figure 48: Position of the Start and Stop logging buttons on the Survey window of 
HySWEEP 
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ð Solution 1: use the VRS stations network of SwissTopo as dGPS base (it is 
necessary to have at its disposal a GSM connection via hotspot and a 
subscription to SwiPos GIS/GEO service to receive real time GPS 
corrections): 

a. Prepare the EchoBoat and connect the boat PC to the shore PC using 
the remote connection 

b. Connect the boat PC to internet using the GSM connection provided 
by a mobile device (your smartphone or the 4G Mobile Huawei 
device) through the hotspot service. If you use the Huawei device, 
please follow these specific steps: 

- Long press the button in the middle of the device 
- Two led will be light up indicating the status of the 

battery and of the connection (green = good; yellow = 
middle; red = bad) 

- On the shore PC, search the network called “Swisscom” 
- Enter the WiFi key 4r6r74hb 
- You are now connected to internet 
- ATTENTION: at the end of the survey remember to turn 

off the device (press again the button and check that the 
connection is no more availabe) 

Note: the Huawei device contains a prepaid card. You can have 4G 
GSM data via WiFi for 24h for a price of 2 CHF/day. When you use 
the network, this cost will be automatically charged. The status of 
the credit could be checked using the “Swisscom cockpit”.  
To reload the credit, connect the device into the “Swisscom cockpit” 
(https://www.swisscom.ch/en/residential/mobile/subscription-
tariffs/top-up-easy-credit.html) by entering the phone number of 
the card (079 691 19 95) and then choose the payment method that 
you wish. 

c. Open MV-POSView on your shore PC 
d. Tools -> NTRIP client (Figure 49) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 49: NTRIP window of MV-POSView 
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e. Enter the information released by the NTRIP service provider  
- Server = www.swipos.ch  
- Port = 2101 
- Username = B1041 
- Password = 823566 
- Mountpoint = define the correction sources (generally is it 
better to use VRS-LV95-LHN95, table 1)  
 

 
 
 
 
 
 
 
 
 

 
ATTENTION: the options “Use POS position” and “Automatically 
select options” must be selected! 
 

f. Press the “Connect” button. The LED on the bottom right side of the 
NTRIP window will turn green meaning that the Pico is receiving the 
corrections (Figure 49).  

 
ð Solution 2: use a physical dGPS base (ex. Trible R10) installing the 

compatible rover on the EchoBoat 
a. Prepare the EchoBoat and connect the boat PC to the shore PC using 

the remote connection  
b. Install the dGPS rover antenna on the EchoBoat’s aft (use an 

appropriate rod) 
c. Connect an RS232 output cable from the installed dGPS antenna and 

plug it to one of the Pico’s topside RS232 COM Port (ATTENTION: 
use the COM 1, 2, 4 or 5 but never the 3!) 

d. Measure the distance between the rover and the IMU reference point 
and the dGPS rover antenna (see point 3.2.11 and Figure 21) 

e. Enter the new offsets for the dGPS rover antenna (Figure 50) 
- Setting 

- Installation 
- Lever Arms & Mounting Angles 

- Sensor Mounting tab 
- Ref. to aux 1 GNSS Lever Arm  

 

Table 1: Characteristics of the different mountpoints available on SwiPos 
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f. Prepare the dGPS base and connect it to the rover  
g. Open MV-POSView and conFigure it to receive corrections (Figure 

51) 
- Settings 

- Input/Output Port  
- Choose the COM Port in which the RS232 output cable 

has been plugged 
- Input select = Aux 1 GNSS 

- Aux GPS input = NMEA standard 
- Baud rate = 38400 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ATTENTION:  
- A positive value for the X lever arm means the auxiliary GNSS antenna is forward of your 
reference point 
- A positive value for the Y lever arm means the auxiliary GNSS antenna is to starboard of your 
reference point  
- A negative value for the Z lever arm means the auxiliary GNSS antenna is above your reference 
point 

Figure 50: MV-POSView and settings location of the distance between the IMU and the 
dGPS rover 

Figure 51: Input/Output Ports Set-up of MV-POSView  
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3.5 Schematics to aid deployment 
 
3.5.1 Schematic view of the steps needed to power the EchoBoat 
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3.5.2 Schematic view of the steps for start a survey 
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3.5.3 IP addresses relative to the different devices installed on the 
EchoBoat 
 

• Devices on the boat: 
- PC ethernet port that MikroTik plugs into = 192.168.1.8 
- MikroTik = 192.168.1.20 
- PC ethernet port that Pico plugs into = 10.0.100.70 
- Applanix system (integrated into the Pico) = 10.0.100.121 

 
• Shore PC: 

- PC ethernet port that MikroTik plugs into = 192.168.1.9 
- MikroTik = 192.168.1.21 
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4. Data post-processing guide on HyPACK 
 
4.1 Download data from the boat PC and import it on your PC 

1. Open the EchoBoat lid 
2. Turn on the PC lever on the aft of the EchoBoat 
3. Turn on the boat PC  
4. Connect the shore PC to the boat PC using the Wifi antenna or the 

ethernet cable (that of the shore antenna) 
5. Connect the two devices using the remote desktop connection from the 

shore PC 
6. Connect a USB or a hard disk to the boat PC  
7. Follow this directory: Computer -> OS (C:) -> HyPACK 2018 -> Projects 
8. Search your projects on the “Project” folder of HyPACK and paste them 

on the hard disc  
9. Shut down the boat PC from the shore PC: start -> shut down 
10. Turn off the PC lever on the aft of the EchoBoat 
11. Remove the HyPACK dongle from the boat PC and put it on your PC 

to pair the HyPACK software with his license 
 
 
4.2 Data post-precessing and filtering on HySWEEP (with Patch Test 
done) 
 

IMPORTANT: If you haven’t already done a Patch Test to calibrate your data 
from the angular errors linked to the EchoBoat’s reel on the water, please 
first complete the activities in Chapter 4.3. The Patch Test is a very 
important operation to adjust your surveyed data. 
 

1. Connect the hard disc to the shore PC, or to a PC having HyPACK 2019 
installed 

2. Paste the project into the “Project” folder of HyPACK 2019 of your PC 
(directory: Computer -> OS (C:) -> HyPACK 2019 -> Projects) 

3. Ensure that the HyPACK dongle is connected to the PC 
4. Open HyPACK 2019 64-bit 
5. Open the project that you want to work on (Figure 52) 

ð Double right click on the name of the project in the “Project 
Files” list 

ð The project name turns green, meaning the you are working on 
it 
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6. On the “Raw Data Files” of the “Project Items” list select the lines/rows 
(*.HSX format) you want to clean (Figure 53) 

ð You can process all the rows at the same time, or you can also 
do it with multiple sub-samples 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

7. Open HySWEEP Editor (64 bit) 
ð HyPACK 2019 main menu -> HySWEEP -> HySWEEP Editor 

64bit (Figure 53)  
ð A new window, called MBMAX64, will be displayed (Figure 54) 

Figure 52: Determination of the project on HyPACK 

Figure 53: Lines selection in HyPACK 
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8. Load the survey in MBMAX64 
ð Click on the yellow folder icon (“Load survey”) (Figure 54) 
ð On the “Open” window click the “Raw” folder (Figure 55A) and 

select the *.HSX format (Figure 55B) 
 

 
ð Select the files (logged lines) that you want to import on 

HySWEEP (CTRL + right click) (Figure 56) 

Figure 54: “Load survey” icon on MBMAX64 windows of HySWEEP 

Figure 55: Load files on HySWEEP. The “Raw” folder (A) contains the HSX surveyed data (B) 

A B 
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9. The “Read Parameters” window will appear 
ð “Survey” tab (Figure 57) 

• Select “Depth Mode” as survey mode 
• Check the “Matrix” values (clicking “Edit” is it possible to 

modify the resolution) -> Choose “Auto Cell Size” to use 
the cell size determined during the survey, or input the 
resolution that you want)  

• Ensure that “Auto Stage 2” is selected on the “Auto 
Processing” list 

• IMPORTANT: Check the “Memory Test” (pay attention 
that the Required Memory is not too high. If needed, 
manually change it setting a value around 20 MB (as 
recommended!).  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 56: Determination and loading of the logged lines in MBMAX64 

Figure 57: Important parameters to check on the “Survey” tab 
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ð “Corrections” tab (Figure 58) 
• This section enables you to apply tide and sound velocity 

corrections to your bathymetric data 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
ð “Devices” tab (Figure 59) 

• Check that “Sonar Head 1” have the corrected offsets 
between the primary GPS antenna and the Pico reference 
point. Edit it if necessary. 

• ATTENTION: MV-POS -> X= forward; Y = vertical 
       HyPACK -> X = vertical; Y = forward  

• Check the “Patch Test” values.  
• The different parameters (GPS Latency, Yaw, Pitch and Roll) 

should be already be set with the values determined during 
the last Patch Test. If not, search the good values on the 
Patch Test Diary (chapter 5), or on the Patch Test History 
(“Edit” button), and manually insert them (clicking on 
“Edit”). 

Figure 58: Load correction files on the “Corrections” tab 
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10. Press “OK” to complete the loading process 
11. The 3D bathymetric model will appear on the MBMAX64 main window 

(Figure 60) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ð Important tools (Figure 60) 
• Zoom extent = draws the 3D model at a zoom scale that 

displays all enabled data 
• Map View = change the 3D model view orthogonally to the 

displayed data (remove the oblique view) 
• Profile View = set the view laterally of the displayed data  
• Show list = type of data displayed (ensure that the option 

“cells” is selected to see the logged data) 

Figure 59: Important parameters on the “Devices” tab 

Style 

Floating Toolbar 

Up to Date  
and 

Update cells 

Edit Tools 

Data editing steps 
and 

data representation 

Undo Check Map view 
Zoom  
extent 

Profile view 

Figure 60: MBMAX64 window, 3D model and principal edit tools 
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• Style = choose the data representation mode  
• Edit Tools = tools to move the 3D data model on the space 

and to edit/filter noise data 
- Measure tool = click and drag this tool between two 

point and the status bar displays measurements 
relevant to the position, distance and direction of the 
measurement 

- Lasso select = defines a free-form area for use with 
delete and filter operations 

- Block select = defines a rectangular area for use with 
delete and filter operations 

- Line select = defines a straight line across your data 
for use with delete and filter operations 

- Eraser = delete small, square areas of data at a time 
- Tilt and rotate = see the data from any angle (click 

and drag in the data display); left-click to move the 
displayed data without applying any rotation 

- Zoom Window = drag a rectangle in the window to 
define the extent of your desired view 

12. The filtering operations are conducted through two different stages 
(“Edit” list) 
 
IMPORTANT: after editing, the “Update Cells” button turns red (Figure 
60). Always click on it to save and update modifications to your data! 
If you are working on a large dataset, you may choose to do multiple 
edit operations and recalculate only once to account for all changes at 
once. During the editing process, to undo the erasure, press the “Undo” 
button or use CTRL+Z.  
 

ð Stage I (Figure 60):  stage I editing includes several display 
windows allowing correction of position data (Speed velocity, 
Heave/tide, Heave Pitch Roll [HPR] and Sound velocity [SV]).  
To delete erroneous data from the graph, select the tool on the 
“Edit Toolbox” list (Lasso, Block, Line or Eraser), select the area 
that you want to delete (in reference to the drawn area) and 
drag the form on the graph. At this stage, there is not a real 
rule defining the erroneous data; in general, it is appropriate to 
delete the spikes! 

ð Stage 2: stage II is where you clean most of the bad/noise data. 
There are two main ways to clean the soundings: 

1. Automatic 
a. Right click on the MBMAX64 main window 
b. Select the “Search and Filter Options” tab 
c. Select the “Basic” tab and choose the filter you 

want to use (Range, Corrected Depth or 
Elevation,…). The filter will delete all point that 
fall outside the filter limits. 
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d. On the “Actions” tab, select the lines to which the 
filter should be applied (“All files” = the entire 
dataset; “Selected files” = selected lines on the 
file list) 

e. All deleted point will be displayed in yellow 
f. ATTENTION: Automatic filtering is fast, but it 

can also be dangerous as is purely statistical 
based! Use with caution!! 

2. Manual  
a. Manual processing gives you full control in 

cleaning your data. This procedure allows you to 
scroll through your data and view them from 
different angles/zooms, in order to take yours 
editing decisions. 

b. The “Sweep 1”, “Profile”, “Cloud” and “More 
Windows” buttons allow you to display the data in 
different ways (Figure 60). The entire dataset is 
displayed on several sections; you can scroll 
within the different sections and lines using the 
arrows during the cleaning operations. To check 
the location of a determined section, look at the 
white lines on the 3D model. 

c. Instructions: 
- Click with the cursor at the beginning of the 
3D model. 

- In each section use the editing tools to 
remove any noise (click on the “Floating 
toolbar” option to have the editing tools on a 
separate window; Figure 60). Use the “Tilt” 
and “Rotate” tools to move the 3D model on 
the space. Press CTRL + Z to undo the editing 
operations. 

- When each section is clean, press the 
“Checked” icon to confirm that the section has 
been reviewed (optional, but very useful to 
track editing progress). 

- Scroll to the next section (Figure 61). 
- Once all the sections of a single line have been 
cleaned, skip to another line (Figure 61). 

- Save the edited data using the red “Update 
Cells” button (Figure 60). Do it periodically to 
preserve your work. 

d. In order to assure that you have reviewed all of 
your data, you should choose a methodical order 
to follow (“edit, check, scroll and, once the line is 
finished, skip line and repeat”) 
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13. Once you have reviewed and cleaned all of your data, save the edited 
rows  

ð File -> Save Survey (Figure 62) 
Use “Save All files” to save the entire edited dataset or “Save 
Selected Files” to save only specific lines. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ð Choose the HS2x file format to save your data on the edited 
format of HySWEEP (the edited rows will be stored on the 
“Edited Data Files” folder in the “Project Items” list of HyPACK 
2019; the original data without any modifications are still stored 
on the “Raw Data Files” folder on the *.HSX format). 

ð Choose the XYZ file format to export the edited data on another 
software, as Matlab or ArcMap.  

Change section  Change line  

Figure 61: Sweep 1 window and change section/line buttons 

Figure 62: HySWEEP saving formats 
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On the “Save survey” window, make sure to select “Save One 
Point per Cell” and “Median” as MTX selection on the “XYZ 
Options” list.  
The *.XYZ file will be saved on the “Sorted Data Files” folder in 
the “Project Items” list of HyPACK 2019; if you don’t see your 
file on the list: right click on “Sorted Data Files” tab -> Add File 
-> search your *.XYZ file. 

 
4.3 Patch Test on HySWEEP 
 
The Patch Test is a data collection and processing procedure to calibrate the 
angular mounting components (GPS Latency, Roll, Pitch, and Yaw) of multibeam 
systems. It is a fundamental process to determine the correction values for the 
logged bathymetric data. Errors in these measurements can lead to systematic 
error propagation into DEM.  
 
Angular components and errors (Figure 63): 
• Latency = delay between position fix and data arrival time which can cause 

positional errors. N.B.: During the Patch test you could also skip the 
analysis of this parameter as the latency error is less important using the 
today’s modern equipment. 

• Roll = vertical misalignment, port and starboard, between sonar and MRU 
can cause depth errors, especially at the outer beams. 

• Pitch = vertical misalignment, forward and aft, between sonar and MRU can 
cause depth and position errors across the swath. 

• Yaw = misalignment of the sonar and gyro relative to the boat frame can 
cause position errors. 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 

Latency 

Yaw 

Roll 

Pitch 

Figure 63: Angular components and related errors 
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IMPORTANT: 
- It is not necessary to do a Patch Test every time a survey is performed 

(do it only in case of modifications on the structure of the EchoBoat; ex. 
disassembly for transportation or maintenance). Nevertheless, it is highly 
recommended to do periodically a Patch Test to check the correction 
values.  

- Since in HySWEEP the calibration of one offset will affect the result of 
subsequent tests, you should process each pair of test lines separately 
following the Latency, Roll, Pitch and Yaw order. Save the results of one 
test and then load the next pair of lines applying the offsets calculated 
thus far (this is usually a good thing to do). 

 
 

Patch Test Steps: 
 

1. In the field  
a. Collect some data on the prescribed pattern for every parameter 

(Figure 64) 
You can do it manually or editing the EchoBoat’s lines (“Line Editor”) 
and then log data using the mission mode (point 3.3.9b). Patch Test 
data could be collected on a single new project or on multiple 
projects, one for each parameter. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 64: Patch Test lines and bottom characteristics for each parameter 
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b. Fill the Patch Test table shown in Chapter 5. Pay attention to 
correctly indicate the name/number of the row. This information is 
displayed on the “Data display” window in HySWEEP (Figure 40). 
 

2. On HyPACK 
a. Load the specific lines with the relative bathymetric data. 

ð Paste the project(s) on the “Project” folder of HyPACK 2019 
64-bit 

ð Open the project that you want to use for the Patch Test 
(one project having all the parameters or one project for 
each parameter)  

ð Double left-click on the name of the project in the “Project 
Files” list. The project name turns green, meaning that you 
are working on it (Figures 33 and 52) 

ð On the “Row Data Files” of the “Project Items” list select the 
test lines/rows (*.HSX format) you want to use (Figure 53) 

b. Clean data from noise  
ð Follow the chapter 4.2 
ð Carry out the operation for the data relative of all 

parameters. Before to proceed with the Patch Test the 
bathymetric data must be cleaned from noise in order to 
extract the right adjustment values! 

c. Load the bathymetric data relative to a single parameter 
ð Open HySWEEP Editor 64 bit (HyPACK 2019 main menu -> 

HySWEEP -> HySWEEP 64 bit; Figure 53 and 54) 
ð The MBMAX64 window will be displayed (Figure 54) 
ð Load the surveyed data relative to a determined parameter 

clicking the yellow folder inside the “Survey Files” menu 
(step 4.2.7 and 4.2.8). As you have already cleaned your 
data, you may search the rows on the “Edit” folder (*.H2Sx 
format). 
ATTENTION: Load and perform the Patch Test for one 
parameter at a time following the Latency, Roll, Pitch and 
Yaw order! The calibration values calculated from each 
test can be applied to each subsequent test for better 
result! 

ð Select the files relative to a single parameter (CTRL+click).  
ATTENTION: On the “Read Parameter” window (“Devices” 
tab), the Patch Test values should be zero (Figure 59)! If 
not, manually change these settings. 

d. Perform the Patch Test for a determined parameter 
ð Click the “A-B Cross Section and Patch Test” button (wrench 

icon; red square on Figure 65)  
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ð Drag the cursor across your data cutting the section that 
you need. For every parameter you have to select a 
different transect of the surveyed area that, in addition to 
take into account the bathymetric characteristics of the 
bottom (Figure 64), should intersect the two sampled lines 
in a different way (Figure 66). 
ATTENTION: it is also possible to do a Patch Test using a 
complete transect on the surveyed data (choose the “Patch 
Test” option from the “Tools” tab). This solution is usually 
not recommended as the morphology of the bottom play an 
important role. Nevertheless, this option could give a first 
overview of the correction needed.  

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Figure 65: “Patch Test” tool and “Remove file from survey” icon on the MBMAX64 
window 

Figure 66: Patch Test’ sections (red lines) for each parameter in 
reference to the test lines (blue lines) 

Patch Test 

Remove files 
from survey 
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ð The Patch Test window will appear displaying the selected 
test data 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
ð For every parameter of the Patch Test do the following 

(Figure 67). 
• Make sure that on the “Show” tab the “Patch Test” option 

is selected 
• On the “Patch Test” tab, select the test that you want to 

run (Latency, Roll, Pitch or Yaw). 
• Run the test with different adjustment settings clicking 

on the “Coarse”, “Medium” and “Fine” tabs. Start with 
the “Coarse” one. 
For every tab, there are different settings (“Angle/time 
steps” and “Number of steps”) with suggested values 
that you can modify if you wish. 

• Click “Start Test”. The software will calculate the 
adjustment needed to overlap the two sampled data. 
You can increase the accuracy of their overlap using the 
“Step-” and “Step+” buttons. IMPORTANT: the plot 
showing the depth error should be U-shaped.  

• Repeat the operation for the “Medium” and “Fine” 
adjustment settings. Once the test data are correctly 
overlapped, and you are satisfied of the correction, click 
the “Test OK” button. 

• To save the final Patch Test value (“Adjustment” value) 
for a determined parameter, press the “Save Test to 
History” button (save the value on the HySWEEP’s Patch 
Test records) and then press also the “Update Config 
Files…” button to apply the calculated values to the 
subsequent loaded data. 

• Apply the adjustment to the data using the red “Up to 
Date” button! 

Figure 67: Patch Test window 
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• To have a more accurate adjustment value, it is 
recommended to perform two time the Patch Test for 
each parameter (if it possible in different locations), and 
then consider the averaged value. 

• Do not forget to fill the Patch Test diary with the 
found values! 

e. Repeat the Patch Test for the other three parameters (Roll, Pitch and 
Yaw) 

ð To load the data relative to another parameter: File -> Add 
Files -> search the files that you need. 
ATTENTION: ensure that the “Read Parameter” window, 
the “Patch Test” tab show the adjustment value for the 
parameter just examined. If you want to use the averaged 
value, you may manually insert it using the “Edit” button. 

ð To delete the files relative to the previous parameter, select 
them (CTRL+right click) and then click the blue cross icon 
(Figure 65) 

ð Repeat the Patch Test’s operations (points 4.3.2b to 4.3.2d) 
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5. Patch Test diary 
 
Figure 68 shows the EchoBoat’s survey trajectories and bottom bathymetry 
needed to carry out an accurate Patch Test (for further information refers to 
chapters 3.2 and 4.3). The Patch Test data should, if possible, be recorded in 
the deeper region of the surveyed area. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Instructions: 
 

1. Usually, if the structure of the EchoBoat is not modified, it is not necessary 
to carry out a Patch Test as the right adjustment values to correct the Roll, 
Yaw and Pitch orientation of the EchoBoat are already loaded in HySWEEP. 
Nevertheless, it is recommended to lead a Patch Test with regularity.  

2. Every time a Patch Test is conducted, please fill the below table with the 
appropriate information in order to have a history relative to the time 
between each Patch Test and the evolution of the adjustment values. 

3. On the Patch Test table, the information within the solid bold lines are to 
be filled during the survey, while those within the dashed lines are to be 
completed during the post-processing when the Patch Test will be 
performed on HySWEEP in order to determine the adjustment values. 

4. The table should be available at any time. Please reprint it once filled! 

Figure 68: EchoBoat’s lines and bottom’s characteristics to perform an accurate Patch Test 
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Parameter Date Project 
name 

Rows  
(# or name) 

Time 
(start/end) 

Observations  Calculated 
values 

Average 
value 

Latency 
       

 

Roll 
       

 

Pitch 
       

 

Yaw 
       

 

Latency 
       

 

Roll 
       

 

Pitch 
       

 

Yaw 
       

 

Latency 
       

 

Roll        
 

Pitch 
       

 

Yaw 
       

 

N.B. Please reprint this table once completed! 
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6. EchoBoat fieldwork: brief summary 
 
1. Open the EchoBoat lid 
 => plug the batteries and the HyPack dongle on the PC 

=> ensure that all cables are correctly plugged 
2. Put the EchoBoat in the water 
3. Install the two fins on the oft of the EchoBoat 
4. Turn on the PC lever 
 => tone from the boat 
5. Turn on the boat PC 
 => tone + lights 
6. Turn on the STARBOARD lever 
7. Turn on the AutoNav 
8. Turn on the PORT lever 
9. Turn on the SONAR lever 

=> turn it on only when the EchoBoat is in the water! If you need to it on 
when the boat is outside the water, ensure that the beam frequency is 1 
Hz 

10. Install the Huawei mobile WiFi on the mast 
=> put the modem on a grip bag to avoid water infiltration and tie it to 
the mast using some tape 

 => press the button to turn it on 
11. Turn on the remote controller  
12. Arm the AutoNav 

=> ATTENTION: arm it only in a safe location (in case that a mission has 
to be aborted) 
=> flip down the arm/disarm lever towards the operator + flip up the 
safety for 3 seconds 

 => tone from the boat 
13. Close the EchoBoat’s lid 
14. Prepare the shore PC station 
 => connect the shore antenna to the shore PC using the ethernet port 
 => connect the shore antenna and the shore PC’s power supply to the 
battery  
 => connect the shore PC to the EchoBoat using the remote connection 
  - username = EchoBoat 
  - password = Seafloor 
 => check the connection bars on the antenna 
 => connect to the Wifi 
  - network: Swisscom-E5573-020A 
  - password: 4r6r74hb 
15. Open MV-POSView 

=> wait until the IP address is displayed (Pico/sonar is connected to the 
boat PC), then press the CONNECT button 
=> check the ACCURACY alarms => if the alarms are not green, 
manually move the boat 

 => press the NAV button 
 => RTK: 
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  - Tools -> NTRIP client 
  - server = www.swipos.ch 
  - port = 2101 
  - username = B1041 
  - password = 823566 
  - Uncheck “Automatically Select Options”  
   -> click on “Request Options” 

-> use the dropdown menu and select the correction 
stream “VRS_GISGEO_LV95LHN95” 
 -> press on “Connect” 

=> Check the total number of satellites connected to the Echoboat (View 
-> GNSS data). They must be between 15 and 20 satellites. 
=> Look if the clock in MV-POSView is synchronized with the boat PC’s 
clock (the maximum delay have to be of maximum 1 second). If not, 
manually change the boat PC. For a correct synchronization is it 
recommended to undertake a remote connection using an ethernet 
cable.  

16. Open HyPACK 
 => create a new project 
 => check the GEODESY 
 => check the HARDWARE settings 

=> SURVEY -> “HyPACK survey and HySWEEP survey” (from the 
“Survey” tab) 

  - look at the alarms on the SURVEY window 
- change the beam FREQUENCY + swath depth and width (c. 1.5 x 
depth) (Tools -> PicoTech controller) 
- determine the MATRIX and select “average depth” and “while 
logging”  
- The number of satellites connected to the EchoBoat is displayed 
on the “Data Display” window 
- Before to record data, wait until the “NO SYNC” alarm is gone 

 => use the START/STOP LOGGING button to record sounding data 
17. Plan a mission 
 => Close the “HyPACK survey and HySWEEP survey”  
 => HyPACK 
  - Line editor 
   - Cursor button -> draw line 

- Offsets button -> add additional lines (N.B. modify 
the single length moving their edges) 

     - Reverse their orientation (CTRL + right click) 
      - Save (from the “File” tab) 
 => Select the lines from the “Planned lines files” folder 
 => Open “HyPACK survey and HySWEEP survey” 
  - MAVLINK => Start Mission 

- For every line, press the START LOGGING button to produce 
several rows 
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- At the end of the mission switch the manual/autonomous mode to 
autonomous and  then again to manual to take control of the 
Echoboat. 

18. At the end of the survey 
 => Turn down the beam frequency to 1 Hz 
 => Close HySWEEP survey to save the logged data 
 => Shut down the boat PC from the shore PC 
 => Turn off the thrusters (PORT and STARBOARD levers) 
 => Turn off the SONAR and the PC lever 
 => Open the lid and turn off the AutoNav 
19. Download data (the shore PC must be connected to the boat PC via remote 
connection!) 
 => plug an USB key (or a hard disk) on the boat PC 
 => Computer -> OS(C:) -> Hypack -> projects 
 => search for your project into the folder 
 => copy it and paste it on your USB key 

=> shut down the boat PC from the shore PC and turn off the PC lever 
on the aft of the EchoBoat 
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7. Annex 
 
1. Mountpoints characteristics  
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2. Configuration of the rover using the SwiPos GIS/GEO service  
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